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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, the fluctuations of climate, and the study of the 
Earth’s deep biosphere.

Although ODP ended operations in 2003, science results from ODP’s expeditions on the JOIDES Resolution 
continue to emerge. The results represent the contributions of scientists and research institutions from 22 ODP 
member countries. International oversight and coordination of the program was provided by the ODP Council, 
which was made up of representatives from the member countries. Scientific and management guidance was 
provided by representatives from the Joint Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 20 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implemented scientific objectives, plans, 
and recommendations of the JOIDES committees through subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.
JOI, TAMU, and LDEO worked together successfully for many years to manage the Ocean Drilling Program. We 
look forward to many exciting discoveries and continued international collaboration on the Integrated Ocean 
Drilling Program as we further our scientific mission.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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PREFACE

THE VOYAGES OF DISCOVERY

The Scientific Results volumes of the Proceedings of the Ocean Drilling Program are about Earth and her oceans.

These volumes contain contributions to a better understanding of the history of our planet through time. This 
exploration of Earthís past is based on scientific analyses of layers of strata sampled by the JOIDES Resolution at 
key locations throughout the global ocean. These volumes are a tribute to the scientific exploration carried out 
by the men and women who contributed to these voyages of discovery. Like the pioneering exploration and 
research of Captain Cook aboard the first Resolution, these volumes are a credit to the human spirit, which sees 
no boundaries.

The papers in this volume are published in a new online format that will be archived on CD-ROM. The 
Proceedings contents are available to students, scientists, and the public throughout the world. Volumes, once 
housed in the libraries of the member nations of the Ocean Drilling Program (ODP), are now published on the 
Internet for a worldwide audience and are also available in CD-ROM format. This electronic publication enables 
future investigators to gain easier access to the results of ocean drilling research. I acknowledge and thank the 
authors for their contributions and willingness to participate in this new venture in our successful transition to 
electronic publications.

Each Scientific Results volume has an Editorial Review Board that is responsible for obtaining peer reviews of 
papers submitted to the volume. This board usually is made up of the two co-chief scientists for the cruise, the 
ODP staff scientist for the cruise, and one external specialist who is familiar with the geology of the investigated 
area. ODP staff coordinate the peer-review process and also edit and produce each paper.

Each Scientific Results volume contains one leg synthesis paper and other peer-reviewed papers that present the 
results of extensive research in various aspects of scientific ocean drilling related to each leg. Each paper 
submitted to a Scientific Results volume undergoes rigorous peer review by at least two specialists in the author’s 
research field. Volumes may also contain short reports of useful data. These Data Reports do not include 
interpretation of results and are peer-reviewed by at least one specialist. We seek to maintain a peer-review 
system comparable to those of the most highly regarded journals in the geological sciences.

To acknowledge the contributions made by this volume’s Editorial Review Board, the Board members are 
designated Editors of the volume. Reviewers of manuscripts for this volume, whose efforts are so essential to the 
success of the publication, are listed without attribution to any particular manuscript.

On behalf of ODP and now the Integrated Ocean Drilling Program, the successor to ODP, I extend sincere 
appreciation to the members of the Editorial Review Board and to the reviewers for generously contributing their 
time and effort. This process ensures that only papers of high scientific quality are published in the Scientific Results 
volumes.
Paul J. Fox
Director, Science Services, TAMU
Integrated Ocean Drilling Program
Texas A&M University
College Station, Texas
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European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
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*At time of completion of ODP cruises in September 2003. See Publisher’s Notes, p. 5, for list of funding agencies at time
of cruise. 
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Federal Republic of Germany, Bundesanstalt für 
Geowissenschaften und Rohstoffe

France, Institut National des Sciences de 
l’Univers–Centre National de la Recherche 
Scientifique (INSU-CNRS)

Japan, University of Tokyo, Ocean Research 
Institute

People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
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Washington DC 20005, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: info@joiscience.org
Web site: www.joiscience.org

ODP SCIENCE OPERATOR

Integrated Ocean Drilling Program
Texas A&M University
1000 Discovery Drive

ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory 
of Columbia University

PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP
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Lamont-Doherty Earth Observatory 
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of Columbia University
PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: ssdb.ldeo.columbia.edu
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http://iodp.tamu.edu/
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http://www.ldeo.columbia.edu/BRG/ODP
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Stephen A. Nathan and R. Mark Leckie
Manuscript number: 184SR-219

9. Oigocene–Miocene Planktonic Foraminifer Biostratigraphy, Site 1148,
Northern South China Sea
Qianyu Li, Zhimin Jian, and Baohua Li
Manuscript number: 184SR-220

10. Early Oligocene–Pleistocene Calcareous Nannofossil Biostratigraphy
of the Northern South China Sea (Leg 184, Sites 1146–1148)
Xin Su, Ylin Xu, and Quiang Tu
Manuscript number: 184SR-224

11. Abundance Variations of Planktonic Foraminifers during the Mid-Pleistocene
Climate Transition at ODP Site 1144, Northern South China Sea
Fan Zheng, Quanyu Li, Xia Tu, Muhong Chen, Baohua Li, and Zhimin Jian
Manuscript number: 184SR-222

GEOCHEMISTRY, MINERALOGY, AND SEDIMENTOLOGY

12. Geochemistry of Pliocene Sediments from ODP Site 1143 (Southern South China Sea)
Rolf Wehausen, Jun Tian, Hans-Jürgen Brumsack, Xinrong Cheng, and Pinxian Wang
Manuscript number: 184SR-201

13. Geochemical and Stable Isotopic Compositions of Pore Fluids and Authigenic Siderite 
Concretions from Site 1146, ODP Leg 184: Implications for Gas Hydrate
Youhai Zhu, Yongyang Huang, Ryo Matsumoto, and Bihao Wu
Manuscript number: 184SR-202

14. Data Report: Late Miocene–Pleistocene Mineralogy, Site 1146
Eve Arnold
Manuscript number: 184SR-203

15. Origin and Nature of Green Clay Layers, ODP Leg 184, South China Sea

Federica Tamburini, Thierry Adatte, and Karl B. Föllmi
Manuscript number: 184SR-206

16. Data Report: Carbonate and Organic Carbon Contents of Sediments
from Sites 1143 and 1146 in the South China Sea
Li-Wen Wang and Hui-Ling Lin
Manuscript number: 184SR-207



20

17. Alkenone Stratigraphy of the Northern South China Sea for the Past 35 m.y., 
Sites 1147 and 1148, ODP Leg 184
J.L. Mercer and M. Zhao
Manuscript number: 184SR-208

18. Data Report: Marine and Terrigenous Lipids in the Sediments from the 
South China Sea, Site 1148, Leg 184
Ping’an Peng, Chiling Yu, Guodong Jia, Jinafang Hu, Jianzhong Song, and Gan Zhang
Manuscript number: 184SR-209

19. Mineralogy and Sedimentology of Pleistocene Sediment in the South
China Sea (ODP Site 1144)
S. Boulay, C. Colin, A. Trentesaux, F. Pluquet, J. Bertaux, D. Blamart, C. Buehring, and P. Wang
Manuscript number: 184SR-211

20. Isotopic Chemistry of Organic Carbon in Sediments from Leg 184
Joel S. Leventhal
Manuscript number: 184SR-215

21. Data Report: Late Miocene–Quaternary Biogenic Opal Accumulation 
at ODP Site 1143, Southern South China Sea
Rujian Wang, Jianru Li, and Baohua Li
Manuscript number: 184SR-217
PALEOCEANOGRAPHY

22. Data Report: Pleistocene Paleoclimatic Cyclicity of Southern China:
Clay Mineral Evidence Recorded in the South China Sea (ODP Site 1146)
Alain Trentesaux, Zhifei Liu, Christophe Colin, Sébastien Boulay, and Pinxian Wang
Manuscript number: 184SR-210
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of selected data tables. A complete listing of the ASCII data 
tables can be found below.

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can 
configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MAC COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS

You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 2 Chapter 5 Chapter 15 Chapter 22
Chapter 3 Chapter 12 Chapter 16
Chapter 4 Chapter 14 Chapter 18
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Chapter 2
Appendix. Stable-isotope data for Globigerinoides ruber (white).

Chapter 3
Table T1. Planktonic carbon and oxygen isotope data.
Table T2. Benthic carbon and oxygen isotope data.

Chapter 4
Table T1. Oxygen and carbon isotope data for planktonic foraminifers, Site 1143.
Table T2. Oxygen and carbon isotope data for benthic foraminifers, Site 1143.

Chapter 5
Table T1. Planktonic foraminifer oxygen and carbon isotope data, Sites 1147 and 1148.
Table T2. Planktonic foraminifer stable isotope data for the spliced section (0–410 mcd)
Table T3. Benthic foraminifer oxygen and carbon isotope data, Sites 1147 and 1148.
Table T4. Benthic foraminifer stable isotope data for spliced section (0–837 mcd).

Chapter 12
Table T1. Inorganic geochemical data for late Pliocene sediments, Site 1143.

Chapter 14
Table T1. Talc-normalized peak areas.
Table T2. Talc- and calcite-normalized peak areas.
Table T3. Mineral peak ratios.

Chapter 15
Table T2. Depths and ages for green clay layers used for statistical analyses.

Chapter 16
Table T1. Coarse fraction, total carbon, TOC, total inorganic carbon, and CaCO3 in sediment 

samples, Sites 1143 and 1146.

Chapter 18
Table T1. Concentrations of marine and terrigenous lipids, Sites 1147 and 1148.

Chapter 22
Table T1. Summary of depth and relative abundance of clay-mineral constituents.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 184 Site Map

ODP Map (Legs 100–Current)

DSDP Map (Legs 1–96)

CD-ROM CONTENTS: INDEX TO LEG 184 INITIAL 
REPORTS AND SCIENTIFIC RESULTS VOLUMES
The index covers both the Initial Reports and Scientific Results portions of Volume 184 of the 
Proceedings of the Ocean Drilling Program. The index contains a subject and taxonomic index.

Index to Leg 184

CD-ROM CONTENTS: COMPILED ELECTRONIC INDEX

The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program contains the indexes of 
Volumes 101–178, 180–184, 186–192, and 196. The indexes are contained in the directory titled 
ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes can be searched 
individually or collectively. For information on using the Acrobat search function, see “Searching a 
PDF Document” in README.PDF.
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CD-ROM DIRECTORY STRUCTURE

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

184SR.PDF
(Preliminary pages and table of contents)

README.TXT

VOLUME
(Leg 184 Scientific Results volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF (ODP map, Legs 100 through 210)

CHAPTERS
(Volume chapters)

184_MAP.PDF (Leg 184 site map)

204.PDF (Chapter 1: Data Report: Mineral
Magnetic Properties of Sediments)

205.PDF (Chapter 2: Stable Isotope Stratigraphy,
Site 1144)

214.PDF (Chapter 3: Data Report: Oxygen and 
Carbon Isotopes)

221.PDF (Chapter 4: Data Report: Site 1143
Stable Isotopes)

223.PDF (Chapter 5: Data Report: Site 1147
and 1148 Stable Isotopes)

212.PDF (Chapter 6: Data Report: Site 1143
Diatom Records)

216.PDF (Chapter 7: Dinoflagellate Stratigraphy)

219.PDF (Chapter 8: Miocene Planktonic
Foraminiferal Biostratigraphy)

DSDPMAP.PDF (DSDP map, Legs 1 through 96)

(Continued on next page)

MAC

WINDOWS

UNIX

INTRO
(Volume introduction)

INTRO.PDF (Introduction: Postcruise Research
Bibliography)

220.PDF (Chapter 9: Oligocene–Miocene
Planktonic Foraminifer Biostratigraphy)

224.PDF (Chapter 10: Early Oligocene–
Pleistocene Calcareous Nannofossil
Biostratigraphy)

222.PDF (Chapter 11: Foraminifer Abundance
Variations)

201.PDF (Chapter 12: Geochemistry of Pliocene
Sediments)

202.PDF (Chapter 13: Pore Fluid and Authigenic
Siderite Concretions)

203.PDF (Chapter 14: Data Report: Site 1146
Mineralogy)

206.PDF (Chapter 15: Green Clay Layers)

207.PDF (Chapter 16: Data Report: Carbonate
and Organic Carbon Contents)

208.PDF (Chapter 17: Alkenone Stratigraphy)

209.PDF (Chapter 18: Data Report: Marine and
Terrigenous Lipids)

211.PDF (Chapter 19: Pleistocene Mineralogy
and Sedimentology)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

101NDX.PDF through 178NDX.PDF, 
180NDX.PDF through 184NDX.PDF, and
186NDX.PDF through 192NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

VOLUME
(Continued)

OVERSIZE
(Large-format figures and tables)

SR184212 (Chapter 6 files)

SR184216 (Chapter 7 files)

SR184219 (Chapter 8 files)

SR184220 (Chapter 9 files)

SR184222 (Chapter 11 files)

CHAPTERS
(Volume chapters, continued)

215.PDF (Chapter 20: Isotopic Chemistry of
Organic Carbon)

217.PDF (Chapter 21: Late Miocene–Quaternary
Biogenic Opal Accumulation)

210.PDF (Chapter 22: Data Report: Pleistocene
Paleoclimatic Cyclicity)

TABLES
(Data tables in ASCII format)

SR184205 (Chapter 2 files)

SR184214 (Chapter 3 files)

SR184221 (Chapter 4 files)

SR184223 (Chapter 5 files)

SR184201 (Chapter 12 files)

SR184203 (Chapter 14 files)

SR184206 (Chapter 15 files)

SR184207 (Chapter 16 files)

SR184209 (Chapter 18 files)

SR184210 (Chapter 22 files)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
184 Scientific Results) 

184NDX.PDF
(184 Proceedings volume index) 
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